SHELL ELEMENTS
BENDED PLATE AND THIN-WALLED BEAM

1. INTRODUCTION

Shell elements geometry is defined by the nodes in the middle surface. Thickness | applied as a
parameter. Stress system includes membrane and bending stresses. Each layer parallel to the
middle surface acts in plane stress. Distribution of normal and shear stress along thickness is linear
(see Figure below). Shell elements can be used to model thin walled structures (vessels and plates)
as well as thin-walled beams. There are six degrees of freedom (DOF) at each node: three linear
displacements and three angles of rotation.
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Fig. The membrane and bending stress components in the shell

Ex_3_Plate and thin walled beam.doc dr inz. Piotr Marek 1



2. PROBLEM DESCRIPTION
2.1. Bending of the rectangular plate

The goal of the analysis is to find deflection and stress components in rectangular plate supported
along edges on pin supports and loaded with constant surface load g.

Data: g=0.1MPa, a=200 mm, b= 300mm, h=4mm, E=2-10° MPa, v=0.3
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2.2. Bending of the thin-walled beam

The goal of the exercise is to find deflection and stresses in the thin-walled cantilever beam loaded

with concentrated load.
Data: P=10 kN, I=5m, B= 100mm, H= 240mm, h1= 13mm, h,= 9mm, E=2-10° MPa, v=0.3
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3. TYPICAL COURSE OF NUMERICAL ANALYSIS

Taking double symmetry of the problem we can built % of the analyses plate. Convenient units are:
mm, N, MPa.

3.1. Bending of the plate

3.1.1 Preprocessor

\ 1. Create rectangle: Preprocessor>Create>Rectangle> By Dimensions
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= Preferences S AREAS
© Preprocessor
© Element Type TRE oM

@ Real Constants
@ Material Props
® Sections
= Modeling
e Create
® Keypoints
© Lines
5 Areas
& Arbitrary
e Rectangle
#ABy 2 Corners

= Transducers

= Operate
m Mava | Madife

B Racefrack Coll H ‘

\ 2. Select element type: Preprocessor>Element Type>Add> SHELL181 \
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3. Define material properties: Preprocessor>Material Props>Material Models:
Structural/Linear/Elastic/lsotropic: EX=2e5MPa, PRXY=0.3
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4. Define element thickness: Preprocessor>Section>Shell> Lay-up>Add/Edit
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oK Cancel Help

5. Define size control: Preprocessor>Meshing>Mesh Tool>SizeCtrl>Global
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8. Plot elements using thickness description
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6. Generate mesh: Preprocessor>Meshing>Mesh Tool>Mesh>Areas (Quad) ‘
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3.1.2. Solution

Define boundary conditions:

9. Define pin support on along edges: Solution>Define Loads>Apply>Structural>Dispalcements>On Lines
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11. Apply surface load: Solution>Define Loads>Apply>Structural>Pressure>0On Areas
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12. Solve the problem: Solution>Solve> Current LS
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then press OK to start the solution.
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3.1.3. General postprocessor

Show the results as contour maps:
Show displacements normal to the plate (UZ), bending stress: stress components (SX, SY)

| 13. Plot displacements UZ |
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15. Plot stress component in Y (SY) |
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3.2. Thin-walled beam

3.2.1 Preprocessor

\ 1. Create keypoint in central point (0,0,0): Preprocessor>Create>Keypoint>In Active CS
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3. Create lines by keypoints: Preprocessor>Modeling>Create>Lines> Stright Line
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4. Create keypoint by copying: Preprocessor>Modeling>Copy>Keypiont
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5. Create lines by keypoints: Preprocessor>Modeling>Create>Lines> Stright Line

ANSYS Main Menu L]
Pl
= Preprocessor B < reate Straight Line
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6. Define size control on lines: Preprocessor>Meshing>Mesh Tool>SizeCtrl>Lines
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7. Extrude lines along line: Preprocessor>Modeling>Operate>Extrude>Lines>Along Lines
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8. Define material properties: Preprocessor>Material Props>Material Models:

Structural/Linear/Elastic/lsotropic:

EX=2e5MPa, PRXY=0.3
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9. Select element type: Preprocessor>Element Type>Add> (SHELL181 i SHELL281)
S s
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=

0t type options

S K T
Add... Options... o = et =
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10. Define section parameters for shell elements: Preprocessor>Section>Shell> Lay-up>Add/Edit
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Layup ISaction Contrals|  Summary

Create and Modify Shell Sections Name| ( 1D[1 ) |

Thickness Material ID Ori i | ion Pts Pictorial View
LGED) l1 oo s ]

Add Layer Delete Layer

T el Haip

Delete Layer |

ol =

Section Offset | Mid-Plane | User Defined Value
-
Section Function|None defined K| KCN or Node K| en=1

oK Cancel Help

11. Define attributes on areas: Preprocessor>Meshing>Mesh Attributes> Picked Areas
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12. Reflect areas: Preprocessor>Modeling>Reflect>Areas

ANSYS Main Menu af |
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13. Reflect areas: Preprocessor>Modeling>Reflect>Areas
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14. Merge geometry: Preprocessor>Numbering Ctrls> Merge Items>Keypoints
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15. Generate mesh: Preprocessor>Meshing>Mesh Tool>Mesh>Areas (Quad)
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= Mesher Opts  #reas S=t Cisar —_—
= Concatenate @ List of Trems
a Mesh e ﬂ 2’  Min, Hax, Inc
= Areas Copy. Flip
a Volumes

aVolume Sw teer 5ot | ol |

@ Tet Mesh F 8 ci
a intertace WEELE ) ke

@ Modify Mesh

aCheck Mesh s w e
@ Clear
@ Checking Ctrls ~ 5"°{*

@ Numbering Ctrls ¢ Free

@ Archive Model

@ Coupling / Cegn
= FLOTRAN Set U
= Multi-field Set U|
= Loads

= Physics

@ Path Operations

| aeny

Jordsided -
G _om
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16. Plot elements using thickness description

L=

UM_DE Numbering

(Plot PlotCiris rk|

View Setting

lane Parameters Macro MenuCtris Help

otate ...
S v

JaE- IR

( Size and Shape

- 5 ge Option
”e Window Controls G
nts Erase Options *  Contours o
| .
PE Animate o Srapns .

Annotation C

. y Light Source ...
. Device Options ..
dbutes oot Plots N Transln_mency
Texturing
Is Hard Copy »
Ipts Background v
Floating Point Format ...

s ResetPlotCirls i

e Displacement Scaling ...

aplure mage .. Vector Arrow Scaling ...
. Restore Image ...
: Swee Write Metafile *  Shell Normals ...
sh Fro 9 Solid Model Facets ...

Multi-Plot Controls ...

Symmetry Expansion

Ee TS Multi-Window Layout .. e
1sh Best Quality Image
trls
Ctris

3.2.2. Solution

Define boundary conditions:

17. Define symmetry B.C. on lines:

Solution>Define Loads>Apply
>Structural>Dispalcements>Symmetry B.C.>On Lines

ANSYS Main Menu &

Preferences =

Preprocessor @ Piek ¢ Unpick

Solution _—

= Analysis Type & single ( Box - \55\3 S,

o DapE P 5
= Settings LE
= Apply

= Structural
o Displacement
#0n Lines
7 0n Areas
#0n Keypoints
#0n Nodes
#A0n Node Components

A0On Areas
=0n Nodes
@ Antisymm B.C.
@ Force/Moment
= Pressure
= Temperature
@ Inertia
B Pretnsn Sectn
E Gen Plane Strain
@ Other
@ Field Surface Intr

1

@ List of Items

" Min, Max, Inc

|

.

e
7 .

18. Constrain central keypoint on Y (UY=0): Solution>Define Loads>Apply
>Structural>Dispalcements>On Keypoints

ANSYS Main Menu

l

| Preferences
Preprocessor
Solution
= Analysis Type
e Define Loads
= Settings
© Apply
& Structural
& Displacement
#0n Lines
~ON Areas
z
=Qn Node:
#0n Node C

~ [DK] Apply Dispiacements (L,ROT) on Keypaints
Lab2  DOFs to be constrained

Constant vakie |

Apply as
T Constant value then:
VALUE Displacement value

KEXPND Expand dsp to nodes?

o |

I~ Ho

sy | cned | wep |

nts,

] |

a2 Symmetry B.C.
#0n Lines
A ...with Area
#0n Areas
2 On Nodes
= Antisymm B.C.
= Force/Moment
= Pressure
= Temperature
= Inertia
B Pretnsn Sectn
B Gen Plane Strain
= Other
& Field Surface Intr

i Apply U,ROT on KPs
[DK] Apply Displacements (U,ROT) on Keypaints
Lah2 DOFs to be constraned

Apply as
" If Constant value then:
VALUE Deplacement value

KEXPND Expand disp to nodes?

Constant vale -

ok | Ay | cmed | wep |
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19. Apply concentrated load on keypoint: Solution>Define Loads>Apply
>Structural>Forces/Moment>0n Keypoints

ANSYS Main Menu ® |

—
B Preferences =
® Preprocessor

& Solution
= Analysis Type
© Define Loads
= Settings
© Apply
& Structural
= Displacement

7 0n NouE Compon:
m From Reactions
@ From Mag Analy
= Pressure
= Temperature
= Inertia
@ Pretnsn Sectn
B Gen Plane Strain
= Other
@ Field Surface Intr
@ Field Volume Intr
@ Initial Condit'n
@ Load Vector
& Functions
® Delete
= Operate

5Fg 5
EGlOn Keypoints| B
&0n Nodes @ List of Trems

[FK] Appiy Force/Woment on Keypodts

@ Pick (" umpack Lab  Direction of force/mom

@ single (" Box Apply as
€ Polygon ¢ carcle T Constant vae then:
SRS VALUE e
Count =1
saximm = 14
oK Apply
w0 a ] e ]
- s

Cn:nsxam valie - ~ Ssslgsss

(cnca | _vew |

I
€ Min, Max, Isc

|

Pick M1|  Belp

20. Solve the problem: Solution>Solve> Current LS

ANSYS Main Menu @)
B Preferences - RAREAS
= Preprocessor .
= Solution e e
@ Analysis Type
@ Define Loads £
@ Load Step Opts
[P Y TP 1,1 soive Current Load step x|

BResults Tracking  [SOLVE]

B Review the summary information in the lister
& From LS File window (entifled "/STATUS Command"),
B Partial Solu then press OK to start the solution.

@ Manual Rezoning
@ Multi-field Set Up
@ ADAMS Connecti

Begin Solution of Current Load Step

@ Diagnostics
B Unabridged Menu
= General Postproc
= TimeHist Postpro
= Topological Opt
= ROM Tool
= DesignXplorer
= Design Opt
@ Prob Design

3.2.3. General postprocessor

Show the results as contour maps:

Show displacements i Y (UY), bending stress: normal stress (SZ) and shear stress in the web (SYZ).

| 21. Plot displacements in Y (U

Y) |

ANSYS Main Menu_

= Preferences i o Ea T
8 Preprocessor s .
& Solution & Favorites

red

= Data & File Opts
= Results Summa
& Read Results
& Failure Criteria
& Plot Results
= Deformed Sh
& Contour Plot

ElNodal Sol

& Plot Path Iten

Scale Factor
B Elem Table
B Line Elem ditional Options
& Veclor PIol

& General Postproc Nodal Solution

& DOF Solution
@ X

@ 7_Camnanant Af dienlasamant

I}

Undisplaced shape key

®50.121

-44.508

-38.894

Undisplaced shape key |Deformed shape with undeformed edge

[Aute Calculated Jl+.98418452018

-33.28

-27.666
®|

ok | ey | cemce |

rop_| -22.053

& Concrete Plof
& ThinFilm
& List Results
= Query Results
= Options for Qutp
@ Results Viewer
m Write PGR File
= Nodal Calcs
= Element Table
= Path Operations

]

-16.439

-10.825

-5.212

.402014
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22. Plot normal stress (SZ)

_ANSYS Main Menu

= Preferences

= Preprocessor

& Solution

= General Postproc
& Data & File Opts

@ Results Summary

= Read Results
= Failure Criteria
= Plot Results

ElNodal Solul

@ Elem Table
@ Line Elem Re
@ Vector Plot
@ Plot Path ltem
@ Concrete Plot
& ThinFilm
@ List Results
= Query Results
@ Options for Qutp
@ Results Viewer
& Write PGR File
= Nodal Calcs
Element Table
Path Operations

Surface Operations

sl
[ comour nogarsowtonbma
i~ Item to be
& Favorites. -
o Nodal Solution
& DOF Solution
® Stress
@ X-Companent of stress
Component of stre:

B oo oS 4
| |
Undisplaced shape key
Undisplaced shape key |Deformed shape only |
Scale Factor True Scalez|1

Additional Options @

oK | Agply ] cmm|| Hlp ‘

23. Select elements attached to areas (web elements)

File gel@gist Plot PlotCtrls WorkPlane Param

EEEEEERL]
AR

0@ e alellin

Sele All Invert

Sele None| Sele Belo |

__ok_| _apply |
Plot Replot
Cancel Help.

SremTeTTTToTT—
= Elem Table

= Line Elem Res
Vector Plot
Plot Path ltem
Concrete Plot
ThinFilm
ist Results
Query Results

= Options for Outp
= Results Viewer

B Write PGR File
Nodal Calcs

@ Elamant Tahla

QUIT| POWRGRPH

- R,
By NumlPick = I

@ Pick Ompiok

@ single  ( Box
C/Pelygm circie
C Loap

Caunt
Massmum

Minimum =
Area Mo. =
@ Lasc of Items

€ Min, Max, Inc

—

o
——
——

" Unselect

Sele All Invert

24. Plot shear stress in the web (SYZ)

ANSYS Main Menu

]

= General Postproc
= Data & File Opts
= Results Summary
& Read Results
& Failure Criteria
& Plot Results

|
1 Item to be contoured
o Stress 5|
@ X-Component of stress ]
@ Y-Component of stress
5[
L] I~

E|

~ Undisplaced shape key

Scale Factor

Undisplaced shape key |Deformed shape with undefor =|

True Sce=|1

Additional Options

8|

oKl

sty | cancal | hen |

Also Select

NODAL SOLUTION

SUB =1

TIME=1

SZ (AVG)
RSYS=0

DMX =50.163

SMN =-138.234

SMX =138.234

-138.234
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-76.7597
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NODAL SOLUTION

Ex_3_Plate and thin walled beam.doc

dr inz. Piotr Marek

13



25. Define path along web height

"2 General Postproc
= Data & File Opts

& Results Summary TSN

@ Read Results

@ Failure Criteria

@ Plot Results

@ List Results

= Query Results

& Options for Outp

= Results Viewer

& Write PGR File

@ Nodal Calcs

@ Element Table

a Path Operations
DefirTe Tl

Y

= Path Status
= Modify Path [oe ] _amn |
Besex | camcer

& Path Option:
@ Delete Path
& Plot Paths
& Recall Path
& Map onto Path
@ Plot Path Item

@ piox

1ime—1
S5YZ (AVG)
RSYS=0

 tmpick

ﬂ

[PATH] Define Path spechications

Name Define Path Name :

nSets Humber of data sets
nDiv  Number of divsions

( |)aam DG

(I

o | omd]| _wep |

-4.98

-4.82

-4.66

-4.5

-4.34

-4.18

-4.02

26. Map shear stress onto path DG

and plot shear stress along height of the web (with nodes)

= General P,

General
[PDEF] Map Resutt ltems onto Path
User label for kem

B Results

Query |
= Option:
= Results
= Write P

= Nodal € Average resuts across element

[AVPRIN] EFf NU for EQV strain

= Elemen

= Path O]
= Defir
= Delel
& Plot
ERg

[/PBC] Show boundary condtion symbol
Show path on depay

Map onto Patp

a0T ms
Path Range

@ Linearized Strs

@ List Linearized

@ Add

& Multiply

B Nivida

Gscale  Scake factor offset
Mopt  Display options :

74\ Plot of Path Items on Geometry

Ex_3_Plate and thin walled beam.doc

dr inz. Piotr Marek

14



4. INTERPRETATION OF THE RESULTS. TASKS TO BE DONE

Solve the problems:
a) Bending of the plate using SHELL181.:
- rough mesh with about 20 elements (ESIZE=30) (Model 1a),
- dense mesh with about 150 elements (ESIZE=10) (Model 1b),

b) Bending of the thin-walled beam:
- model using 4 noded SHELL181 (Model 2a)
- model using 8 noded SHELL281 (Model 2b)

Discuss the results.

Model 1a Model 1b Model 2a Model 2b
PLATE (SHELL181) | (SHELL181) BEAM 4 noded 8 noded
rough dense (SHELL181) (SHELL281)
No. of nodes No. of nodes
No. of elements No. of elements
UZmax UYmax
SXmax Szmax
SYmax SYZmax (Web)
fmax fmax
meax GG
Gymax GD
Tmax

Plots needed (should be archived during program session for each model):

For plate: for beam:
1) FE mesh. 1) FE mesh.
2) UZ(x.y) 2) UY(xy)
3) SX(x,y) 3) SZ(x,y)
4) SY(xy) 4) SYZ(x,y) in the web
5) graph: SYZ along DG (point 26)

Final report:

1) Introduction

2) Assumptions for the modeling

3) model description (solid model, mesh, boundary conditios and loads)
4) Results

5) Results in the Table

6) Discursion

7) Conclusion
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